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SUMMARY

Protein kinase C-d (PKC-d) is a key enzyme controlling growth, differentiation,
and apoptosis in various cells, including immune cells. Here, we present a
protocol to determine PKC-d activation in response to increased membrane-
bound diacylglycerol or phorbol-12-myristate-13-acetate treatment in murine
bone-marrow-derived dendritic cells. We describe steps for dendritic cell differ-
entiation, the isolation of plasma membrane lipids, and the quantification of di-
acylglycerol. We then detail procedures for measuring PKC-d kinase activity by
in vitro assay, indirect immunofluorescence, and western blotting experiments.
For complete details on the use and execution of this protocol, please refer to
Parsons et al.1
BEFORE YOU BEGIN

Protein kinases C (PKC) are multifunctional serine/threonine protein kinases that are essential regu-

lators of signal transduction in gene expression, protein secretion, cell proliferation, angiogenesis,

and inflammatory and immune responses.2 Thus, the need to determine their activity in various cell

types in developmental and physiological events is quite recurrent in research.

The PKC family comprises a family of lipid-activated isoforms. PKC is a subfamily of kinases that

share a highly conserved catalytic kinase domain and a less conserved regulatory domain respon-

sible for binding to activators and anchoring proteins. Isoforms of PKC can be divided into three

sub-classes: classical, novel, and atypical, according to activation requirements. Classical PKC

(cPKC) isoforms, including a, b (I and II) and g, require both Diacylglycerol (DAG) and calcium to acti-

vate. Novel PKCs (nPKCs – d, ε, h and q), are activated only by DAG-binding. Atypical PKC contains a

single zinc-finger motif that needs to be bound by zinc-finger proteins for activation.3 Although

these kinases might have partially redundant functions, their expression pattern and levels are

cell-type specific, and each isoform executes specific functions in defined cells. For instance,

PKC-d is one of the PKC isoforms highly expressed in dendritic cells (DCs) and specifically involved

in regulating the Major Histocompatibility Complex II (MHCII).4,5 PKC-d is activated exclusively by

membrane-bound DAG or its analogous phorbol 12-myristate 13-acetate (PMA) that anchors

PKCs in their active conformations to membranes, which favors the autophosphorylation of serine

643 of PKC-d.6

In the main manuscript linked to this STAR Protocol, we demonstrated that peroxisomes, essential

cellular metabolic organelles important in developmental processes7 and recently established as
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core regulators of immunometabolism8 in multiple immune cells,8–13 are required to provide mem-

brane DAG in stimulated DCs to activate PKC-d in response to immune stimuli.1 The activation of

PKC-d is essential for MHCII-mediated antigen presentation by DCs to CD4+ T cells.1

Here, we present a step-by-step protocol we optimized tomeasure the amount of membrane-bound

DAG and to assay the activation of PKC-d in bone-marrow-derived DCs upon Lipopolysaccharide

(LPS) stimulation. In the reported protocol, we use in-house-optimized assays integrated into proto-

cols from commercially available kits to measure PKC activity in vivo in wild-type DCs that can syn-

thesize DAG in response to stimulus and in peroxisomemutant DCs with defects in DAG production.

Peroxisome functions depend on a set of peroxin (PEX) proteins.7 Depletion of PEX proteins inhibits

peroxisome biogenesis and metabolic functions7 including synthesis of DAG.1 Our optimized multi-

method approach was designed and validated to obtain rigorous results of PKC-d activity in cells.

While many kits are available to obtain the same results, we had the need to test, select, and opti-

mize reagents and techniques necessary to determine PKC-d activity with high reproducibility. The-

protocol below was used to measure PKC-d activity in murine DCs of Peroxin2 homozygous

(Pex2�/�) null mouse, and their wild-type (WT) littermates or in WT murine DCs unstimulated and

stimulated with LPS or PMA. However, the protocol can also be used for human DCs, other mamma-

lian immune cells, and other cell types of any genotype of interest. This protocol represents a robust

assay to test PKC activities in every signal transduction these kinases might regulate, and it provides

an easy-to-follow guide to assay PKC-d activity in multiple systems.
Institutional permissions

This protocol involves the use of the Pex2 mutant mouse from 129S6.129-Pex2tm1Plf/Mmmh (null

allele) strain,14 which was obtained from the Mutant Mouse Resource & Research Centers

(MMRRC), supported by the National Institutes of Health. We maintain the Sw129-Pxmp3tm1Plf �/�

(indicated in the text as Pex2�/�) mice as stable inbred lines in the SwissWebster and 129SVEV back-

grounds under approved animal protocol #21-023, abiding by the Canadian Council on Animal Care

standards.
Murine bone-marrow-derived dendritic cells

Timing: variable

Note: A minimum of 21 days is required to obtain day 0 postnatal mice plus 9–15 days to

differentiate hematopoietic cell progenitors into DCs.

To differentiate bone marrow hematopoietic cell progenitors into dendritic cells:

1. Establish the mouse line needed for the experiment. For the strain used in this protocol, we fol-

lowed these steps:

a. Cross two heterozygous Pex2�/+ females and one male heterozygous Pex2�/+.

b. Harvest the litter on day 0 postnatal.

c. Dissect tibias and femurs and remove muscle and connective tissue using sterile forceps.

d. Cut bones into small pieces using a razor blade.

e. Grind the bones on a 70-mm cell strainer using the back of the plunger of a 1 mL syringe.

f. Collect in 2 mL of Roswell Park Memorial Institute medium (RPMI), glutamax 1%, 10% Fetal calf

serum, penicillin/streptomycin (1%)

2. Count the cells at the hemocytometer.

3. Seed 1,000,000 cells/2 mL media in 6 well plates.

4. Culture the cells in RPMI, glutamax 1%, 10% Fetal calf serum, penicillin/streptomycin (1%) supple-

mented with Granulocyte-macrophage colony-stimulating factor (GM-CSF) (20mg/ml) for three

days following recovery at 37�C and 5% Carbon Dioxide (CO2).
2 STAR Protocols 5, 103208, September 20, 2024
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CRITICAL: change the culture medium every two days and split cells before they reach
80% confluency at each passage.
5. Harvest cells using gentle non-enzymatic cell dissociation reagent Phosphate-buffered saline

(PBS) 13, Ethylenediaminetetraacetic acid (EDTA) 0.5 mM, and pull them together with cells in

suspension.

6. Count the cells at the hemocytometer.

7. Spin the cells down in a centrifuge at 250 3 g for 10 min at 4�C and resuspend the pellets in the

complete medium supplemented with 10 mg/mL GM-CSF for five days.

8. Seed 200,000 cells in 24 well plates on coated coverslips (for immunofluorescence analyses) or

1,0000,000 cells in 6 well plates (for western blotting and lipid or kinase assays).

9. Add Interleukin-4 (IL-4) (10 mg/mL) in addition to GM-CSF, by two days.

Note: Use an equal number of male and female mice in each experiment, unless sex-specific

studies are required.
Treatment of DCs with phorbol 12-myristate 13-acetate or 1,2-dioctanoyl-sn-glycerol

Timing: 6 h

10. Incubate differentiated WT and Pex2�/� DCs for 1 h with 25 ng/mL phorbol 12-myristate

13-acetate (PMA) or 10 mM 1,2-dioctanoyl-sn-glycerol.

11. Stimulate the cells with LPS 100 ng/mL in a 3-h experiment at 37�C.
12. Use the cells for downstream assays (e.g., indirect immunofluorescence experiments) or harvest

them for kinase assay, DAG assay, or western blotting analyses.
Isolation of cell membranes

Timing: 2 h

13. Remove the medium and rinse the cells with ice-cold PBS 13.

14. Harvest cells using a gentle non-enzymatic cell dissociation reagent, PBS 13, EDTA 0.5mM, and

pull them together with cells in suspension.

15. Transfer cells to 15 mL tubes.

16. Count the cells using a hemocytometer.

17. Centrifuge a cell suspension of 2,000,000 cells in a 15mL conic tube in a centrifuge at 2503 g for

10 min at 4�C.
18. Resuspend the pellets in 0.25M STKM buffer and sonicate in a sonicator bath to yield lysates.

19. Centrifuge lysates at 1,000 3 g for 10 min at 4�C.
20. Centrifuge the supernatant from this first spin at 10,000 3 g for 20 min at 4�C.
21. Centrifuge the supernatant from this second spin, which contains fragmented membranes at

100,000 3 g at 4�C for 1 h.
Extraction of lipids from cell membrane extract

Timing: 90 min

This section describes the method to extract diacylglycerol lipids from plasma membrane.

Note: We followed and modified this method from the Diacylglycerol Assay Kit (Abcam

AB242293-1001) the manufacturer’s protocol.
STAR Protocols 5, 103208, September 20, 2024 3
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Note: The Diacylglycerol Assay Kit suggests extracting lipids from�13 107 whole cell lysates

and resuspending the pellet in PBS 13. Alternatively, we use cell membranes extracted from

�2 3 106 cells and resuspend the pellet in 0.25 M STKM.

Resuspend the resultant pellets from steps 20 and 21 in 1 mL of 0.25 M STKM (Figure 1).

22. Add 1.5 mL of methanol.

23. Add 2.25 mL of 1 M NaCl and 2.5 mL chloroform to the sample. Vortex thoroughly.

24. Centrifuge at 150 3 g for 10 min at 4�C to separate the phases.

25. Carefully remove the upper aqueous phase and discard.

26. Add 2 mL of pre-equilibrated upper phase (PEU) to the lower chloroform phase.

27. Separate the phases by centrifuging at 1500 3 g for 10 min at 4�C. Carefully remove the upper

phase and discard it.

28. Repeat steps 27 and 28.

29. After the final wash, carefully transfer the lower phase to a glass vial using a 2 mL syringe.

CRITICAL: Do not transfer any remaining upper, aqueous phase.

30. Dry the lower phase in a speed vacuum.

Note: It will take �2 hours to obtain wholly dried pellets.

31. Resuspend the dried sample with 50 mL of 13 Assay Buffer from the Diacylglycerol Assay Kit (Ab-

cam AB242293-1001) (Figure 1).

Pause point: Samples may be stored at �80�C for up to a month.

Note: In our experience, fresh lipid extracts from the plasma membrane pellet are preferred.
Protein extraction for PKC activity assay and western blotting

Timing: 90 min

32. Harvest cells using a gentle non-enzymatic cell dissociation reagent, PBS 13, EDTA 0.5mM, and

pull them together with cells in suspension.

33. Transfer cell suspension to 15 mL tubes.

34. Count the cells using a hemocytometer.

35. Centrifuge a cell suspension volume equivalent to 2,000,000 cells for the PKC-d assay or

200,000 cells for western blotting at 250 3 g for 10 min at 4�C.
36. Resuspend pellets in 100 mL of cold lysis buffer in the Kinase Activity Assay kit (or 70 mL of PBS 13

or Ephrussi-Beadle Ringer’s solution 13 for Western blotting).

37. Determine protein concentrations in every protein extract using the Qubit protein assay kit

following the manufacturing protocol (Brochure: Qubit fluorometers and assays).

Note: The Kinase Assay Dilution Buffer is ready to use as supplied in the PKC Kinase Activity

Assay kit.

CRITICAL: Protein quantification using the Qubit assay is preferred because it is a fluores-
cence-based assay and, therefore, more accurate than colorimetric assays. Accuracy in the

quantification of the lysate is essential for normalization in the kinase activity

quantification.
4 STAR Protocols 5, 103208, September 20, 2024
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Figure 1. Diagram representing the main steps of the lipid extraction protocol
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Coverslip preparation for cell seeding and immunofluorescence imaging

Timing: 17 h

The following steps are modified from Weaver et al., 2022.15

38. Wash 12 mm diameter round glass coverslips with distilled water.

39. Dry the coverslips using clean, delicate task wipers.
STAR Protocols 5, 103208, September 20, 2024 5
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40. To prepare the concanavalin A working solution, dissolve 0.5 mg of concanavalin A in 1 mL of

distilled sterile water. Store at 4�C for one year.

41. Coat glass coverslips with concanavalin A by submerging each coverslip in the concanavalin A

solution for 30 min.

42. Rinse the coverslips with distilled sterile water.

43. Allow to dry under ultraviolet (UV) light before seeding cells.

Note: We usually leave the coverslips to dry 16 hours under UV light.
KEY RESOURCES TABLE
REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

PKC-d Cell Signaling Technology D10E2

P-PKC-d Cell Signaling Technology Ser643/676

a-Tubulin Sigma-Aldrich T5168

Horseradish peroxidase-linked secondary anti-rabbit Bio-Rad 1662408

Horseradish peroxidase-linked secondary anti-mouse Bio-Rad 1706516

Goat anti-rabbit IgG (H + L) cross-adsorbed
secondary antibody, Alexa Fluor 488

Thermo Fisher Scientific A-21429

Chemicals, peptides, and recombinant proteins

Lipopolysaccharides from Escherichia coli O55:B5 Sigma L2880-25MG

Penicillin-Streptomycin Thermo Fisher Scientific 15140122

RPMI, glutamax 1% Cytiva SH300096.01

HyClone Super Low IgG fetal bovine serum heat inactivated Cytiva SH30898.03H

Bovine serum albumin (BSA) Sigma-Aldrich A3299

Non-fat dry milk Sobeys N/A

PBS 10 X Thermo Fisher Scientific 70011044

Pierce 16% formaldehyde (w/v), methanol-free Thermo Fisher Scientific 28906

Complete protease inhibitor Roche 11697498001

Triton X-100 Sigma-Aldrich 9036-19-5

Tween 20 Sigma-Aldrich P1379

Sucrose Sigma-Aldrich S8501

Tris base Sigma-Aldrich 93362

Sodium dodecyl sulfate (SDS) Sigma-Aldrich 436143

HEPES-KOH Sigma-Aldrich H0887

Potassium acetate Sigma-Aldrich 27-08-2

NaCl Sigma-Aldrich 7647-14-5

EDTA Sigma-Aldrich 60-00-4

Chloroform Sigma-Aldrich 67-66-3

Glycine Sigma-Aldrich 56-40-6

43 Laemmli protein sample buffer for SDS-PAGE Bio-Rad 610747

Tris base Fisher BioReagents 77-86-1

Ammonium persulfate (APS) Thermo Fisher Scientific 5523UA

30% Acrylamide/Bis solution 29:1 Bio-Rad 1610156

Tetramethylethylenediamine (Temed) Bio-Rad 161-0800

1,4 Dithiothreitol (DTT) Roche 10197777001

PhosStop Roche 4906837001

Recombinant murine GM-CSF 20 mg PeproTech 315-03

Recombinant murine IL-4 20 mg PeproTech 214-14

Phorbol 12-myristate 13-acetate Sigma-Aldrich 524400

1,2-dioctanoyl-sn-glycerol Sigma-Aldrich 317505

Recombinant murine IFNg 20 mg eBioscience 575308

DAPI Pro-Gold antifade reagent Thermo Fisher Scientific P36931

Concanavalin A MP Biomedicals 195283

Alexa Fluor Plus 488 Phalloidin Thermo Fisher Scientific A12379

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Critical commercial assays

PKC Kinase Activity Assay Kit Abcam AB139437

Diacylglycerol Assay Kit Abcam AB242293-1001

Qubit Protein Assay Thermo Fisher Scientific Q33211

Experimental models: Cell lines

Male and female murine bone-marrow-derived
dendritic cells extracted from Sw129-Pxmp3tm1Plf�/+

(WT) And Sw129-Pxmp3tm1Plf�/� (Pex2�/�)

Research Centre (MMRRC)
supported by the NIH

Faust and Hatten14

Experimental models: Organisms/strains

Mouse genotype 129S6.129-Pex2tm1Plf/Mmmh sex:
males and females Age: day 0

Mutant Mouse Resource
and Research Center

Faust and Hatten14

Mouse Swiss Webster sex: males and females
Age: day 0

Charles River 024

Software and algorithms

Fiji/ImageJ software NA https://imagej.net/16

Zeiss Zen lite black https://www.zeiss.com/microscopy/us/
products/software/zeiss-zen-lite.html

Prism10 GraphPad https://www.graphpad.com/

Other

Hemocytometer Fisher Scientific 0267110

Forceps FTS 11150-10

12 mm diameter round glass coverslips Ted Pella 2603

CO2 incubator for cell culture Eppendorf CellXpert C170

Superfrost Plus microscope slides Fisherbrand 1255015

Benchtop centrifuge Eppendorf 5427R

Benchtop centrifuge Eppendorf 5810R

Centrifuge concentrator Eppendorf Vacufuge plus

Confocal microscope Zeiss LSM 880 with Airy scan

Microplate reader BMG Labtech, Ortenberg, Germany CLARIOstar Plus

Qubit fluorometers Thermo Fisher Scientific Qubit 4

Class II biological safety cabinet The Baker Company Sterilgard III Advance

ChemiDoc Bio-Rad N/A

T25 EasYFlask, TC surface, filter cap Fisher Scientific 156367

6-well tissue culture plate Falcon 38021

24-well tissue culture plates Falcon 353046

Nitrocellulose membrane Bio-Rad 1620115

Handcast gel accessories Bio-Rad Mini-PROTEAN Tetra Handcast Systems

Western blotting equipment Bio-Rad Mini Trans-Blot Cell

ll
OPEN ACCESSProtocol
MATERIALS AND EQUIPMENT

Alternatives: The described buffers were made using chemicals from specific brands we pre-

fer in our laboratory. Similar tools from any other manufacturer can be used.

Alternatives:Othermanufacturers produce theprotein kinase kit assay, suchas theKinaseEnzyme

System from Promega or the PKC Kinase Activity Kit from Enzo Life Sciences. We encourage

readers to try these other kits and evaluate which is the most sensitive and robust in their assay.

Alternatives: DAG measurement kits are also available from other manufacturers, such as the

General DAG ELISA Kit from MyBioSource or the DAG ELISA kit from Biomatik. We invite the

readers to consider these other options if a colorimetric assay is preferred to a fluorescent-

based assay.
STAR Protocols 5, 103208, September 20, 2024 7
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STKM buffer

Reagent Final concentration Amount

Sucrose 0.25 M 8.5 g

HEPES-KOH (pH 7.4) 25 mM 2.5 mL of 1 M solution

Potassium acetate 25 mM 0.24 g

MgCl2 5 mM 0.047 g

EDTA 0.1 mM 0.003 g

ddH2O – 97.5

Total 0.25 M 100 mL

Store at 4�C for up to 3 months.
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CRITICAL: It is essential to verify that the solution is pH 7.5. Since the solution is rich in
sucrose, it is important to visually inspect its clarity. A turbid solution indicates contamina-

tion and should be discarded.
Cold lysis buffer (Ephrussi-Beadle Ringer’s solution)

Reagent Final concentration Amount

EDTA 10 mM 0.014 g

Dithiothreitol (DTT) 10 mM 0.050 mL of 1 M stock in ddH2O

Roche complete protease and phosphatase inhibitors 13 1 tablet

ddH2O – 4.950 mL

Total – 5 mL

Store at �20�C for up to 3 months.
PEU (pre-equilibrated upper phase) Solution

Reagent Final concentration Amount

Chloroform 52% 50 mL

NaCl 1 M 0.47 M 45 mL

Total – 95 mL

Store at 20�C–22�C for up to 1 year.

TBST

Reagent Final concentration Amount

NaCl 1.5 M 88 g

Tris base 200 mM 121.1 g

Tween-20 1% 0.01 L

ddH2O – 0.99 L

Total 103 1 L

Store at 20�C–22�C for up to 1 year.

10%

Rea

ddH

Acr

Tris

SDS

Am

TEM

Tot

Pre

8

CRITICAL: pH to 7.6 with 12 N HCl.
polyacrylamide gel

gent Final concentration Amount

2O – 3.8 mL

ylamide 30% 3.4 mL

-HCl, pH 8.8 1.5 M 2.6 mL

10% 100 mL

monium persulfate (APS) 10% 100 mL

ED 100% 10 mL

al – 10 mL

pare fresh.
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Rea
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Tris

SDS

APS

TEM
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Rea

Tris
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SDS

ddH

Tot
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Rea

Tris

Gly

Me

ddH

Tot

Pre

5%

Rea

TBS

ddH

No

Tot

Sto
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CRITICAL: Acrylamide and bis-acrylamide are neurotoxic. All the steps should be per-
formed wearing powder-free gloves.
Note: Tomake Tris-HCl pH 8.8, dissolve 18.15 g of Tris base in 80 mL of distilled water. Adjust

pH to 8.8 using 6N HCl. Make up the final volume to 100 mL with distilled water.

CRITICAL: TEMED must be the last ingredient added.
stacking gel solution

gent Final concentration Amount

2O N/A– 5.86 mL

ylamide 30% 1.34 mL

-HCl, pH 6.8 0.5 M 2.6 mL

10% 100 mL

10% 100 mL

ED 100% 10 mL

al – 10 mL

pare fresh.
CRITICAL: To make Tris-HCl pH 6.8, dissolve 6 g of Tris base in 80 mL distilled water.
Adjust pH to 6.8 using 6N HCl. Make up the final volume to 100 mL with distilled water.
SDS-PAGE Running Buffer

gent Final concentration Amount

base 12.5 mM 30 g

cine 100 mM 144 g

0.05% (w/v) 5 g

2O – 0.99 L

al – 1 L

re at 20�C–22�C for up to 1 year.
Note: for 500 mL of 13 SDS-PAGE Running Buffer, add 100 mL of 53 SDS-PAGE Running

Buffer to 400 mL of ddH2O.
tting buffer

gent Final concentration Amount

base 25 mM 3.025 g

cine 190 mM 14.425 g

thanol 20% 0.2 L

2O – 0.8 L

al 13 1 L

pare fresh.
Note: For proteins larger than 80 kDa, SDS should be included at a final concentration of 0.1%.
blocking solution for western blotting

gent Final concentration Amount

103 13 5 mL

2O 0.753 45 mL

n-fat dry milk 5% 2.5 g

al – 50 mL

re at 4�C for up to 1 week.

STAR Protocols 5, 103208, September 20, 2024 9
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Note: When using an antibody that detects a phosphorylated site of a protein, use BSA

instead of non-fat dry milk.
Fixing solution

Reagent Final concentration Amount

16% methanol-free formaldehyde 4% 1 mL

Calcium–magnesium-free phosphate buffer saline (13) 0.753 3 mL

Total – 4 mL

Store at 4�C for up to 1 week.
CRITICAL: Formaldehyde is a potent carcinogen and should only be handled within a fume
hood while wearing appropriate PPE.
PBST-working solution

Reagent Final concentration Amount

Calcium–magnesium-free phosphate buffer saline (103) 13 10 mL

ddH2O 0.753 89.9 mL

Triton X-100 0.1% 0.1 mL

Total – 100 mL

Store at 20�C–22�C for up to 1 year.
5% blocking solution for immunofluorescence

Reagent Final concentration Amount

PBS 103 13 5 mL

ddH2O 0.753 42.5 mL

FBS 100% 5% 2.5 mL

Total – 50 mL

Store at 4�C for up to 1 week.
Note: 0.1% Tween-20 could be used in substitution of Triton-X to make PBST if milder perme-

abilization is required.

STEP-BY-STEP METHOD DETAILS

Quantification of diacylglycerol

Timing: 4 h

This step enables us to measure the amount of DAG in the cell membrane (Figure 2).

This section describes Diacylglycerol quantification using the Diacylglycerol Assay Kit (Abcam

AB242293-1001) following a protocol extracted and modified from the manufacturer’s protocol.

We report the use of this specific kit for the specific experimental pipeline of this protocol; the kit

gave reproducible results in measuring lipids also from a low amount of samples and, most impor-

tantly, from plasma membrane extracts. We tried a few kits (e.g., General DAG ELISA Kit from

MyBioSource or DAG ELISA kit from Biomatik) to detect DAG changes in cells of different geno-

types, and under various stimulations, but the sensitivity and reproducibility of the assay kit reported

herein were superior in our hands and for the specific sample amount. The higher sensitivity and ac-

curacy of this assay kit could depend on the fact that the assay is fluorescent-based and not

colorimetric.

The general steps of the kit manual are reported below to ease protocol flow for the users. Moreover,

we highlight our modification at each step when required.
10 STAR Protocols 5, 103208, September 20, 2024
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Figure 2. Diagram representing the key steps of the DAG measurement assay
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Table 1. Enzyme mixture

Enzyme mixture (mL)
Fluorometric
probe (mL)

Total volume of detection
enzyme mixture (mL)

Number of tests in a 96-well
plate (100 mL/test)

5 50 5.05 100

2.5 25 2.525 50

1.25 13 1.263 25

ll
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It is still recommended to consult the online manual when performing the assay.

CRITICAL: Follow the manufacturer’s instructions (manufacturer’s protocol.) to properly
thaw, prepare, and maintain every kit component during the assay and for long-term

storage.
12
CRITICAL: Make a series of dilutions of the DAG Standard ranging in concentration from
0 to 2 mM using 13 Assay Buffer. Fresh standards must be prepared for each assay, as

standard dilutions have limited storage capability.
Note: It is mandatory to use fresh samples and test multiple dilutions to ensure readings fall

within the standard range.

CRITICAL: For each sample replicate, create two paired wells. In one well, add the Kinase
Mixture (+Kin), while in the other, replace it with 13 Assay Buffer (-Kin). This is important to

identify the phosphatidic acid background.
Note: To obtain reproducible data, test two technical replicates and three biological repli-

cates per condition.

1. Add 20 mL of the DAG Standards, samples, or blanks into each well of the 96-well microtiter

plate.

2. Add 20 mL of Kinase Mixture to the standards and one-half of the paired sample wells and incu-

bate the plate on an orbital shaker for 2 min to mix.

3. Add 20 mL of 13 Assay Buffer to the other half of the paired sample wells and incubate the plate

on an orbital shaker for 2 min to mix thoroughly.

4. Place the samples in an incubator set at 37�C for 2 h.

5. Carefully transfer 20 mL of the mixture into a 96-well plate appropriate for fluorescence

measurement.

6. Add 40 mL of Lipase Solution to each well in the plate.

7. Place the plate in an incubator set at 37�C and incubate it for 30 min.

8. During step 7 incubation, prepare the necessary amount of the Detection EnzymeMixture sepa-

rately, as reported in Table 1, according to the manufacturer’s protocol. and follow these steps:
a. In a fresh sterile tube, add the appropriate volume of Enzyme Mixture.

b. Add the required volume of the Fluorometric Probe to the Enzyme Mixture and mix well by

pipetting up and down 4–6 times.

c. Use the mixture immediately.
9. Transfer 50 mL of the freshly prepared Detection Enzyme Mixture to each well.

10. Swirl the plate clockwise for 10 seconds and anti-clockwise for 10 more seconds.

11. Cover the plate wells with a suitable cover to protect the reaction from light.

Note: We use an optical adhesive cover to seal the plate and aluminum foil to protect it from

light.

12. Incubate the plate at 20�C–22ºC for 10 min.
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13. To read the plate, use a fluorescence microplate reader specifically equipped to provide exci-

tation within the 530–560 nm range and detect emission within the 585–595 nm range.
PKC kinase activity assay

Timing: 4–5 h

This section measures the PKC kinase activity of the samples in an ELISA-based assay that detects

the accumulation of phosphorylated substrate.

14. Prepare the untreated and treated samples following steps 10–12 and 33–38 of the ‘‘before you

begin’’ section.

CRITICAL: Test the samples at different dilutions to empirically determine the optimal
dilution. In our hands, using 2,000,000 DCs, and performing a 1:5 dilution of each extract

gave a good signal. The samples were diluted in Kinase Assay Dilution Buffer (provided in

the Abcam AB139437 kit).
The step-by-step section below describes how to measure PKC kinase activity using the PKC Kinase

Activity Assay Kit (AbcamAB139437) following themanufacturer’s protocol. We recommend the use

of this kit as, in our hands, we obtained highly reproducible data. We tried luminescent-based kinase

assays such as PKCd Kinase Enzyme System from Promega or the radioactive-based protocol previ-

ously described17; however, the assay kit reported herein was more accurate and sensitive and did

not require purification of the enzyme that can lead to high variability between biological replicates.

The steps are reported here to ease the protocol’s flow for users and highlight our modifications at

the specific steps. However, it is still recommended to consult the online manual when performing

the assay.

CRITICAL: For the success of this experiment, equilibrate all materials and prepare re-
agents following the manufacturer’s protocol instructions.
15. Carefully add 50 mL of Kinase Assay Dilution Buffer to each PKC substrate microtiter plate well.
a. allow the plate to incubate at 20�C–22ºC for 10 min.

b. using a multichannel pipette, gently remove the liquid from each well by aspiration.
16. Fill the designated wells with 30 mL of Kinase Dilution Buffer (blank), 30 mL of the step 14 sam-

ples, and 30 mL of controls.

17. To start the reaction, add 10 mL of diluted adenosine triphosphate (ATP) to every well, excluding

the blank. Incubate for 90 min at 30�C.
18. Remove the contents from all the wells.

19. Add 40 mL of Phosphospecific Substrate Antibody into every well, excluding the blank.

20. Incubate the reactions at 20�C–22ºC for 60 min.

21. Wash wells four times with 100 mL 13 Wash Buffer.

CRITICAL: To reduce background, it may be necessary to wait 1–2 minutes between each
wash.
Note:After the 4th wash, aspirate the liquid from all wells. Invert the plate and carefully pat dry

on clean paper towels.

22. Add 40 mL of diluted anti-rabbit IgG-HRP conjugate to each well (except blank). Incubate at

20�C–22ºC for 30 min.
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23. Add 40 mL of Phosphospecific Substrate Antibody to each well (except blank). Incubate at 20�C–
22ºC for 60 min.

24. Perform four washes using 100 mL of 13 Wash Buffer each time as reported in step 21.

25. Fill each well with 60 mL of Tetramethylbenzidine (TMB) substrate. Allow it to incubate at 20�C–
22ºC for 30–60 min.

Note: The time of incubation is determined empirically by the researcher based on the reac-

tion’s color development. We find that 1 hour is necessary to obtain the optimal reading range

for the standard curve. We use this as a reference in all our experiments to get robust and

reproducible results.

26. Add 20 mL Stop Solution 2 to each well.

27. Measure plate at Optical Density (OD) 450 nm.

Note: Kinase activity was normalized to protein concentration, as determined by the Qubit

Protein Assay (‘‘before you begin,’’ step 38).
Measuring the amount of P-PKC-d by immunofluorescence and microscopy

Timing: 18 h

To confirm that the activity level measured with the PKC Kinase Activity Assay Kit indicates the acti-

vation status of the PKC isoform of interest, it is recommended to assay the amount of phosphory-

lated PKC isoform (activated form) of interest in each sample type by indirect immunofluorescence.

In this protocol, we test PKC-d activation by detecting phosphorylated serine 643 residue of PKC-

d (activated form) in DCs cells.

Note: The antibodies used in this protocol detect the activated form of the novel PKC d.

However, antibodies that detect other PKC isoforms, such as phosphorylated (activated) forms of

PKCa/b (Thr638/641) (classical PKC) or Phospho-PKCz/l (Thr410/403) (atypical PKC), could be

used in this assay, according to the research question.

The following steps are modified from Weaver et al., 2022.15

28. Fix the cells in 4% paraformaldehyde in PBS for 30 min.

29. Rinse the cells with PBST (1 X PBS + 0.1% (v/v) Triton X-100) buffer.

30. Permeabilize the cells by incubating them in PBST for 10 min.

31. Incubate for 1 h at 20�C–22ºC in blocking buffer (5% FBS in 13 PBS).

32. Incubate for 16 h at 4�C on an orbital shaker with primary antibody at a 1:100 dilution in 5% FBS

in PBST.

33. Wash three times for 2 min in PBST.

34. Use the anti-rabbit 555-Alexa Fluor secondary antibodies 1:1000 dilution in 5% FBS in PBST and

488-fluorescently labeled phalloidin to stain the cytoskeleton.

CRITICAL: Use the recommended antibodies specific to the phosphorylated serine 643
residue of PKC-d to measure the amount of phosphorylated PKC-d (P-PKC-d) reported

in the key resource table as we validated the high specificity and low background.
14
Note: The choice of fluorophores for the secondary antibody and the fluorescently labeled

phalloidin is our preference but not required. Any other combination of fluorophores would

equally work (e.g. anti-rabbit 488-Alexa Fluor and 555-fluorescently labeled phalloidin).
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Figure 3. Quantification of P-PKC-d staining in immunofluorescence experiments using ImageJ

(A) Example of images acquired at the confocal microscope. The left image represents WT DCs stained with anti-P-

PKC-d antibody and secondary Alexa Fluor 555 (red). The right image shows WT DCs stimulated with LPS. Red is P-

PKC-d. Blue is the nucleus stained with DAPI. Scale bar, 10 mm.

(B) The dot plot represents the median fluorescent intensity (MFI) of the red channel staining per cell. The error bars

represent the standard deviation of the mean. Statistical analysis was performed using an unpaired Student’s t test.

**** < 0.0001.
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35. Perform four washes of 2 min each using PBST.

36. Mount the coverslips in DAPI Pro-Gold Antifade Reagent.

37. Image using a Zeiss AxioObserver LSM 880 Airyscan, 633 1.4 oil plan-Apochromat lens.

Alternatives:We use a Zeiss AxioObserver LSM 880 Airyscan with a 633 1.4 oil plan-Apochro-

mat lens, but any other confocal microscope can be used.
Quantification of immune fluorescence signals

To determine the relative amount of the defined protein within a mutant cell and compare it to the

amount in the WT cell, we quantify the fluorescent signal following a quantification protocol modi-

fied from Weaver et al., 202215 (Methods video S1 and Figures 3A and 3B).

38. Open the ImageJ software.

39. Click the ‘‘File’’ tab,
a. click ‘‘Open’’ to open the Tif file you want to quantitate.
40. Click on Image, select Colors
a. select ‘‘Split channels’’ to obtain three separate windows, one for each of the three-color

channels.
41. Hit ‘‘OK’’ at the bottom right of the window to proceed to the next quantification step.

42. Click on the ‘‘Freehand selections’’ button and then use the drawing pen to circle the area of the

cell to be quantitated.

43. Click the ‘‘Analyze’’ button to select the ‘‘Measure’’ option.
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Note: A window named ‘‘Results’’ will then pop up, including several measurements the soft-

ware made on the chosen area, including Median Intensity.

a. Copy the median value in an Excel sheet for each cell measured. Measure at least 25–30 cells

per genotype and condition.

44. Repeat step 7 to select and measure a non-fluorescent area of the same image (MFI

background).

CRITICAL: It is preferable to subtract the backgroundMedian Fluorescence Intensity (MFI)
from the MFI of a region of interest (ROI) while analyzing images since the background of

an image might affect the MFI quantitation.
45. Calculate the final MFI = MFI of an ROI – MFI of Background.

46. Copy and paste the value in Prism10 to represent results in a diagram and conduct statistical

analyses.

Note: In the example reported in Figure 3 andMethods video S1, we calculated statistical sig-

nificance using an unpaired Student’s t test. However, you need to use a 2-way ANOVA test to

compare the values between more than two samples.
Preparation of protein extracts for SDS-PAGE

Timing: 15 min

This step involves preparing the protein lysate samples to be loaded into the SDS-PAGE.

47. Thaw on ice the cell lysates prepared in steps 33–38 of ‘‘before you begin.’’

48. Add 30 mL mL of hot (70�C) 43 SDS-PAGE sample buffer containing 10 mM (Dithiothreitol) DTT

to the homogenate.

49. Boil the lysates at 100�C for 10 min.

50. Centrifuge particulate matter at 16,000 3 g for 1 min.

51. Transfer supernatant to a fresh tube for analysis by SDS-PAGE.
Gel preparation and running SDS-PAGE

Timing: 3 h

This step separates the available proteins in the sample mixture based on their molecular weight.

The steps in this section are extracted and partially modified from https://www.sigmaaldrich.com/

CA/en/technical-documents/protocol/protein-biology/gel-electrophoresis/sds-page.

52. Prepare 10% polyacrylamide gel:
16
CRITICAL: Acrylamide and bis-acrylamide are neurotoxic. All the steps should be per-
formed wearing protective gloves.
a. Use methanol to clean the gel casting unit’s glass plates and spacers.

b. Set up the plates by arranging them on a flat and stable surface, ensuring the inclusion of

spacers.

c. Create the resolving gel solution using the specified volumes (10 mL) based on the table in

the ‘‘materials and equipment’’ section.

d. Pour the gel solution into the glass plates with spacers.
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CRITICAL: To ensure a uniform and level gel surface, cover it with isopropanol.

e. Allow the gel to solidify at 20�C–22�C for approximately 30 min.
53. Based on the table in the ‘‘materials and equipment’’ section, prepare a 5% stacking gel solution

using the specified volumes (for 10 mL).

54. Dispose of the isopropanol overlay on the resolving gel.

55. Pour the 5% stacking gel solution until it is overflowing.

56. Insert the comb promptly, ensuring no trapped air bubbles are in the gel or near the wells.

57. Allow the gel to solidify at 20�C–22�C for approximately 40 min.

58. Transfer the gel into the running chamber.

59. Add the required volume of 13 Running Buffer to the inner space between the gel(s) and the

gel’s holder. Fill the outside chamber with the remaining 13 Running Buffer.

60. Load all samples and Molecular Weight standards into the gel lanes.

61. Connect the anode and cathode, cover the chamber, set the electrophoresis power supply

voltage to a constant 150 V, and turn the power supply ON.

62. Allow the gel to electrophorese for 90 min.

Note: Monitor the gel during the run and stop when the dye front reaches the bottom of

the gel.

Protein detection by western blotting

Timing: 18 h

This step identifies P-PKC-d or unphosphorylated PKC-d in the sample and provides information on

their relative abundance. Quantifying the ratio of the amount of P-PKC-d versus the amount of un-

phosphorylated PKC-d in each analyzed sample indicates the level of activation of the kinase in

the sample of each genotype or under each analyzed condition relative to the total amount of pro-

tein present in each sample. This method is complementary to the other reported above as it is the

most accurate to determine whether differences in kinase activation reflect changes in protein

amount (Figure 4A).

63. Resolve the protein by 10% SDS-PAGE and transfer to nitrocellulose membranes:
a. Fill a tray with blotting buffer.

b. Pre-soak the fiber pads in the blotting buffer.

c. To create a blotting sandwich, place the gel holder cassette in the container with the black

side down, immersed in the buffer, and the white side up and out of the buffer.

d. To assemble the layers correctly, follow these steps: Place a flat fiber pad on the black plastic.

Then, place a piece of blotting paper, followed by the gel and nitrocellulose membrane.

Next, place a second sheet of wet blotting paper on top of the nitrocellulose membrane,

and finally, place a second wet fiber pad on top of the blotting paper.

Note: Ensure no bubbles between the pad and the paper and that the buffer covers the pa-

per. Use a roller to remove air bubbles between the gel and the membrane.

Note: Carefully place the membrane on the gel, ensuring it is centered. Place the sandwich

into the electrophoresis chamber and fill the chamber with blotting buffer.

e. Turn on the power supply and run the blot at 110 V for 1 h.

f. Place the sandwich into a container filled with blotting buffer. Remove each layer from the

first fiber pad until you reach the nitrocellulose membrane.
64. Block the Membranes with 5% bovine serum albumin (BSA) or 5% non-fat dry milk for 1 h at

20�C–22�C and then pour off the blocking solution.
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Figure 4. Quantification of P-PKC-d by western blot analysis

(A) The diagram illustrates the main steps of a western blotting analysis.

(B) Example of western blot measuring P-PKC-d and PKC-d amount in lysates of the reported genotypes.

(C)The dot plots represent the calculated ratio of P—PKC—/PKC—indicating the level of activated kinase in each

analyzed sample and the calculated ratio.

(D) The dot plots represent the calculated ratio of PKC/ b-tubulin, indicating the total protein level present in each

analyzed cell extract.

Error bars represent the standard deviation. Statistical analysis was performed using an unpaired Student’s t test. ****

< 0.0001; ns, not significant.
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65. Incubate for 16 h with primary antibody (1:1000 final dilution in TBST).

66. Wash three times for 5 min each with Tris-buffered Saline with Tween 20 (TBST).

67. Incubate the washedmembranes with an appropriate secondary antibody (1:10,000 dilution) for

1 h at 20�C–22�C.

Note: The dilution for the primary and secondary antibodies is determined and suggested

based on the manufacturer’s instructions.
18 STAR Protocols 5, 103208, September 20, 2024



ll
OPEN ACCESSProtocol
Note: BSA blocking buffer is preferred when an antibody recognizes a protein’s phosphory-

lated site. However, the manufacturer’s instructions should be consulted.

68. Wash the membranes three times for 5 min each with TBS containing 0.1% Triton X-100.

69. Detect immunocomplexes by enhanced chemiluminescence using appropriate horseradish

peroxidase–linked secondary antibody.

70. Develop using a ChemiDoc Imaging System.

Note:Measure the P-PKC-d and PKC-d in each lysate and calculate the ratio. Compare the ra-

tio between samples to define the degree of activation of PKC-d (phosphorylated form) in

each sample (Methods video S2 and Figure 4B).

CRITICAL: Use a-Tubulin protein as loading controls

71. To determine the density of bands on a western blot image, we use ImageJ and the protocol

reported in https://imagej.net/ij/docs/menus/analyze.html#gels.16 The protocol is also re-

ported in the article associated with this STAR Protocol.1 The following steps will allow the quan-

tification (Figure 4B and Methods video S2).
a. File>Open.

b. The gel analysis routine requires the image to be a gray-scale image. To convert to gray-

scale, go to Image>Type>8-bit.

c. Use the rectangular selection tool to outline the first lane.

Note: The rectangle should be tall and narrow to enclose a single road.

d. Select Analyze>Gels>Select First Lane (or press ‘‘1’’), and the lane will be outlined as ‘‘Lane 1

selected’’ displayed in the status bar.

e. Move the rectangular selection right to the next lane and select Analyze>Gels>Select Next

Lane (or press ‘‘2’’). The designated lane is outlined and labeled, and ‘‘Lane n selected’’ is

displayed in the status bar.

f. Repeat the previous step for each remaining lane.

g. Select Analyze>Gels>Plot Lanes (or press ‘‘3’’) to generate the lane profile plots.

h. Use the straight-line selection tool to draw baselines and drop lines so that each peak of in-

terest defines a closed area.

i. For each peak, measure the size by clicking inside with the wand tool.

j. Select Analyze>Gels>Label Peaks to label each measured peak with its size as a percent of

the total length of the measured peaks.

k. The values from the Results window can be moved to an Excel spreadsheet program.

i. Calculate the ratio between the density of a protein of interest over the density of a protein

used as loading control for each sample and treatment.

CRITICAL: Measure the ratio between P-PKC-d and PKC-d in at least three independent
cell lysates (three distinct cell differentiation obtained by three mice) for each genotype

and condition.
l. Transfer the values of each ratio into Prism10 to plot them for each analyzed group.

m. Perform statistical analyses using a two-way ANOVA test to determine the significance of the

observed changes between samples of interest.
EXPECTED OUTCOMES

Utilizing the approaches illustrated in this protocol, we can measure the PKC activity in primary im-

mune cells such as DCs and any other murine or human primary or transformed cell line where the
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kinase is expressed. Using the PKC-activity kit, we can analyze the activity of any PKC in the cell lysate

of interest (e.g., mutant) relative to controls (e.g., WT) to probe its status in a specific signaling. In this

protocol, we determine the activation status of PKC-d in WT DCs compared to DCs extracted from a

mutant mouse that lacks functional peroxisomes.1 The kinase activity assay data are coupled to west-

ern blotting and immunofluorescence experiments using antibodies specific to the phosphorylated

serine 643 residue of PKC-d to measure the amount of phosphorylated PKC-d (P-PKC-d) and unphos-

phorylated PKC-d. An increase in P-PKC-d that correlates to the increase in kinase activity measured

in the PKC assay, would confirm that PKC-d is a major PKC isoform acting in the cell of interest in a

specific biological process. Moreover, the measurement of DAG in the plasmamembrane ofWT and

mutant cells allows to determine whether the reduction in PKC-d activity is caused by metabolic de-

fects that affect the PKC-d0s activator DAG. The combination of these quantitative and qualitative

approaches can be used to assess the requirement of PKC-d or other PKC isoforms in multiple

cell types or tissue extracted from mammalian model organisms or humans.
QUANTIFICATION AND STATISTICAL ANALYSIS

Diacylglycerol assay data analysis

The following steps are extracted and modified from the manufacturer’s instructions of the Diacyl-

glycerol Assay Kit (Abcam AB242293-1001) (manufacturer’s protocol):

1. Calculate the average ‘‘Relative Fluorescence Unit’’ (RFU) values for each sample, control, and

standard using an Excel spreadsheet.

2. Subtract the average zero standard value from itself and all standard values.

3. Plot the values of the standard to graph the standard curve.

4. Subtract the average sample well values without Kinase Mixture (-Kin) from the average sample

well values containing Kinase Mixture (+Kin) to obtain the difference.

a. Net RFU = (RFU+Kin) - (RFU-Kin).

5. Use the Net RFU values to calculate the DAG concentration from the standard curve chart equa-

tion obtained in Excel.

6. Transfer the DAG concentration values into Prism10 to plot the values. Statistical significance be-

tween samples is determined using a two-way ANOVA test.

CRITICAL: Calculate the DAG concentration in a minimum n = 3 biological replicates (three
distinct cell differentiation obtained by three individual mice) for each genotype and in

each condition (e.g., LPS stimulated versus vehicle-treated cells).
Calculations PKC kinase activity in cell lysate

Timing: 1 h

This method follows the PKC Kinase Activity Assay Kit (AbcamAB139437) manufacturer’s protocol to

calculate PKC activity in samples of interest.

Determine the average absorbance values for each sample, control, and standard measurement

obtained at the plate reader, using an Excel spreadsheet. Then, subtract the blank readings from

samples and calculate relative kinase activity in each biological replicate per genotype and condi-

tion using the following equation:

Relative Kinase Activity =
Avg absorbance

�
sample

� � Avg absorbance ðblankÞ
Amount of crude protein used per assay

3Dilution factor
CRITICAL: The kinase activity must be measured in a minimum n = 3 biological replicates
(three distinct cell differentiation obtained by three mice) for each genotype and in each

condition (e.g., LPS stimulated versus vehicle-treated cells). The kinase activity values
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are transferred into Prism10 to plot the values for each analyzed group. Statistical signif-

icance between samples is determined using a two-way ANOVA test.
LIMITATIONS

One of the primary limitations we faced in our experimental approach was the possibility of lipid

cross-contamination between the cellular membrane and the cytoplasm during the lipid extraction

process. Preventing the unintentional mixing or transfer of lipids between these distinct cellular

compartments was critical in maintaining the accuracy and reliability of our results. Another limita-

tion of this approach is that the PKC kinase assay is not specific for PKC-d. Therefore, to define which

kinase is mainly be measured in the assay in the specific sample type or condition, if expression data

are not available for our sample, it is necessary to pair the PKC kinase assay with expressional profile

analyses (e.g., western blotting) to determine the isoform present in the assessed samples and its

activity.

Additionally, we faced the challenge that not every kit we tried to measure DAG concentration and

PKC activity was sensitive or highly reproducible to analyze our samples in our hands. We estab-

lished that the kits reported in this protocol were reliable and sensitive for our samples.
TROUBLESHOOTING

Problem 1

Lipids cross-contamination between membrane and cytoplasm (‘‘before you begin’’ step 13–27).
Potential solution

It is crucial to ensure complete separation of supernatant and pellet at each centrifugation step and

to pipette to avoid pellet contamination in the soup carefully.
Problem 2

Uneven loss of lipids (‘‘before you begin’’ steps 25–27).
Potential solution

At the beginning of the vacuum dry step, the supernatant could bubble out of the tube, resulting in

uneven material loss across different samples. To prevent this, the final step of the extraction proto-

col should be performed in glass tubes that are at least five times larger in volume than the handled

volume.

After extraction, it is important to hold the tubes against a light source to detect any speckles dried

on the wall of the tube. Carefully resuspend all of it to ensure complete recovery of the lipid contents.

It is advisable to use glass tubes and capillary tubes instead of plastic to prevent uneven loss of lipids.
RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Francesca Di Cara (dicara@dal.ca).
Technical contact

Questions about the technical specifics of performing the protocol should be directed to and will be

answered by the technical contact, Francesca Di Cara (dicara@dal.ca).
Materials availability

No new reagent or animal model was generated in this study.
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Data and code availability

No data or code was generated.

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2024.103208.

ACKNOWLEDGMENTS

This work was funded by a Project Grant from the Canadian Institutes of Health Research to F.D.C., a

Discovery Grant from the Natural Sciences and Engineering Research Council of Canada to F.D.C., a

Canada Foundation for Innovation JELF equipment grant to F.D.C., and a Dalhousie Medical

Research Foundation start-up fund to F.D.C.

Microscopy was performed at the Dalhousie University Faculty of Medicine Cellular and Molecular

Digital Imaging Facility. We thank Gerard Gaspard for his help with microscopy.

AUTHOR CONTRIBUTIONS

S.M.M. and A.M.M. wrote the Protocol. S.M. developed the figures. F.D.C. conceived the project

and edited the manuscript.

DECLARATION OF INTERESTS

The authors declare no competing interests.
REFERENCES
1. Parsons, B.D., Medina-Luna, D., Scur, M.,
Pinelli, M., Gamage, G.S., Chilvers, R.A.,
Hamon, Y., Ahmed, I.H.I., Savary, S.,
Makrigiannis, A.P., et al. (2024). Peroxisome
deficiency underlies failures in hepatic immune
cell development and antigen presentation in a
severe Zellweger disease model. Cell Rep. 43,
113744. https://doi.org/10.1016/j.celrep.2024.
113744.

2. Steinberg, S.F. (2008). Structural basis of
protein kinase C isoform function. Physiol. Rev.
88, 1341–1378. https://doi.org/10.1152/
physrev.00034.2007.

3. Lim, P.S., Sutton, C.R., and Rao, S. (2015).
Protein kinase C in the immune system: from
signalling to chromatin regulation.
Immunology 146, 508–522. https://doi.org/10.
1111/imm.12510.

4. Majewski, M., Bose, T.O., Sillé, F.C., Pollington,
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